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About this document 
This document includes seven introductory tutorials to take new users through many key features of  
TI-Nspire™ maths and science learning technology. This technology includes both handhelds and 
computer software, providing teachers the flexibility to meet different classroom needs. However, the 
primary focus of these tutorials is the handheld device. All activities are equally applicable to the 
computer software but screen shots and key presses relate to the handheld. 
 
 

About the tutorials 
The tutorials are designed to be worked through in order, with later ones building on skills covered 
earlier. The first time you meet a new technique, there are very detailed instructions about which keys 
to press – but, as you would expect, the amount of detail is reduced when the technique is used 
subsequently.  
In an Appendix you will find an example that links together several of the applications introduced 
separately in the tutorials. As well as enabling you to revisit many of the techniques you met earlier, it 
provides an example of the use of “multiple representations” of mathematical concepts. 
 

 

References 
 
In the tutorials you will find occasional references to three documents that are supplied in electronic 
form with your TI-Nspire handheld.  They are also available from http://education.ti.com/guides.  
They are: 

TI-Nspire Handheld, Guidebook Part 1 
TI-Nspire Handheld, Guidebook Part 2 
TI-Nspire Reference Guide 

 
  
Key features of TI-Nspire™ 

• Multiple representations, dynamically linked, encouraging different approaches to solving 
problems and expressing solutions. 

• A complete set of mathematical tools for algebra, geometry, number, statistics, and real-
world data collection—all in one package. 

• Working documents that can be saved, recalled, edited, and distributed electronically. They 
can be transferred between handhelds and between handheld and computer. 

• A tool for concept and skill development across all the secondary school years. 

 

 

 

First edition for TI-Nspire handheld version 1.2, November 2007. 

Revised for TI-Nspire handheld version 1.3, February 2008. 

Revised for TI-Nspire handheld version 1.4, August 2008. 
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TUTORIAL 1.  
TI-NSPIRE DOCUMENTS  

This first tutorial introduces some of the key features of TI-Nspire™ learning technology, in particular 
the structure of TI-Nspire documents, with different applications operating on different pages. The 
various menus are introduced, together with creating and navigating around documents. 

The tutorial assumes that you are using the TI-Nspire handheld device and the tutorial begins by 
drawing a comparison between this and other types of technology. 

 

a) Is it a calculator? Is it a computer? ….It’s a h andheld  

Pick up the TI-Nspire handheld device and, if you are used to using a calculator, particularly 
a Texas Instruments TI-83 or TI-84 graphics calculator, you are likely to feel a certain re-
assuring familiarity: there’s a screen and a keyboard laid out in a fairly familiar way. As 
usual the on-off switch is in the bottom left-hand corner. So press �  to switch on.  

(Note: nothing on the screen? You probably need to fit the batteries. See Guidebook, Part 1. p.7f.) 

Please don’t worry about what’s on the screen for the moment, but think about how to 
switch it off.  The �  key has “off” written in light blue so that’s the one to use, preceded by 
the blue key marked � .   

But just a minute, it was a key marked 2nd that you used on the calculators, and the change 
to the use of a ctrl  key is quite significant.  Designers at TI have moved to making this 
device much more like a computer and it has a ctrl key, � , and also a shift key � .  All 
the black keys on the handheld have second functions written in blue at the top of the key 
and these are activated using the ctrl key.  Notice for example � , �  and 	 . 

The ctrl key can be used in conjunction with the alphabetic keys to create keyboard 
shortcuts just as you are used to doing on a computer. For example, you can copy and 
paste using �
  and �� . There’s also that most useful keyboard shortcut for 
undoing a previous action, �� .  
(See Guidebook, Part 1. p.6 for a full list) 

b) The Home Screen  

When you switched on a calculator you 
expected to see what was called the Home 
Screen and you’d be able to start entering 
calculations right away. But the TI-Nspire 
handheld is different in this respect too.  

Press 
 , the home button, a white key at 
the top right of the keypad. You should see a 
screen similar to this. 

Navigate to the various icons on the Home 
Screen using the large blue circular button on 
the keyboard – the so-called NavPad. Please 
do not press anything else yet!  

 

 
The TI-Nspire’s Home Screen 

The ctrl key can be used in two ways that have the same effect: 
either press and release (as on a calculator) 
or  press and hold      (as on a computer.) 

As you move from icon to icon, notice the explanatory 
text that appears at the bottom of the screen. 
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Consider whether the TI-Nspire’s home screen is more reminiscent of a calculator or of a 
computer. 

When a computer wakes up you first see the desktop and in many ways this TI-Nspire 
Home Screen is similar. With a computer you have to choose an application to use -- 
a word-processor, spreadsheet or whatever. You then must open a document within which 
you will be able to write text, do calculations, manipulate images etc.  

Computer:  Desktop  á  Choose application  á  Open document 

In many ways working with TI-Nspire is similar. You always have to work within a document 
and you can use different applications to draw graphs, calculate, manipulate text etc.  
What is quite different from the computer is that within one document you can have sections 
that use as many different applications as you like. The spreadsheet on one page of a 
document can interact seamlessly with calculations done on another page and graphs 
drawn on another. You can even have more than one representation on one page.  
This use of multiple representations is what makes the TI-Nspire such a powerful tool for 
doing mathematics. So with TI-Nspire you first open a document and then choose an 
application. 

TI-Nspire:  Home page  á  Open document  á  Choose application 

 

c) Documents, problems and pages   

Just like a computer, documents can be stored on the TI-Nspire handheld – it has a memory 
capacity of about 28 MB. To see what documents are pre-loaded on your handheld you 
need to use option 7 on the Home screen: My Documents . 

Either: 
    navigate to My Documents with the NavPad 
    and press �  
or: 

    simply press �  to choose option 7. 

You should see a screen called the Document 
Browser  and it will be something like the one 
shown here. Documents are organized into 
folders as they would be on a computer. 

Move the cursor to the folder entitled “Getting 
Started.” Press �  or �  or  �  on the NavPad 
to open the folder. The Document Browser  

 

 

 

 

 

 

 
You can very often use either  

�  or �  as alternative key presses 

The icon on the top right corner of the screen is an indication of 
remaining battery charge––the batteries in the handheld used for 
this screenshot were running low! 
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You will probably find a document entitled 
“Getting Started” on your handheld. Use �  to 
locate and �  to open the document  

If the handheld has been used previously you 
will see a dialog box asking you if you want to 
save the document that was being used 
previously.   

Unless you want to save your previous work 
press �  or  �  to move the highlight to No. To 
confirm this choice press either �  or � . 

 

 

 
A dialog box  

 

When the document opens you may see a 
screen similar to the one shown on the right. 
For the moment please do not follow the 
instructions on the screen! Continue working 
through this tutorial, which will introduce you to 
many of the key features of the TI-Nspire 
document model. 

Among these key features are useful and easy 
ways to navigate through documents.  

For example, pressing �  �  will take you to 
the next page in a document. Similarly, 
pressing �  �  returns you to the previous 
page.  

Pressing � �  will take you to the Page 
Sorter  which enables you to move quickly and 
easily through the pages of a document. 

 

 

 

Page 1.1 of a document  

Notice the information typically provided on the 
Page Sorter: 

·  the name of the document; 

·  the number of the problem that  
you are currently working in; 

·  the total number of pages in the 
problem.  

A TI-Nspire document may consist of multiple 
problems and each problem may consist of 
multiple pages. The document shown here 
consists of at least two problems, with 2 and 
7 pages, respectively. 

 

 

The page sorter 

�  is often used to move to and 
highlight different parts of the screen. 

Notice the current page number 
highlighted at the top of the screen. 
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Scroll downwards with the NavPad and you will see all the problems in the document.   
If you move the highlight onto Problem 2, say, and press �  the pages of that problem will 
close up. Pressing �  or � �  takes you back to single page view. 
Each page of a document can contain  
one or more of the core TI-Nspire applications. 
These applications are 

1. Calculator 
2. Graphs & Geometry 
3. Lists & Spreadsheet 
4. Notes 
5. Data & Statistics 

The use of each of these applications is 
covered in the tutorials that follow.  

Any page can be divided into as many as 
four work areas, allowing up to four different 
applications to be used per page. Shown here 
is a page that has been split into two with the 
Notes  application on the left, and the  
Lists & Spreadsheets  application beside it. 
 

 

 

 
Two applications on one page  

 

 

 
d) Different menus for different environments  
 

Return to the Home screen, and select 7: 
My Documents to access the document 
browser.  

Press � , the key located below 
 .  

This opens a menu providing access to 
management features of the document 
browser as shown here.  

Items that are grey, rather than black in a 
menu cannot be chosen in the current 
environment. For example, on the screen on 
the right, option 3: Save As…  was unavailable 
because, in the document browser, a folder 
had been selected. If a document had been 
selected, Save As… would have been 
available and would have enabled you to 
make a copy of the chosen document.  

Try this for yourself; first avoid selecting  
from the menu by pressing � .  

Then select either a folder or a document in 
the browser and press �  again. 

 

 

 

The menu for the document browser 

 

If the document Getting Started is present on your handheld, work through it now as far as 
page 4.3. This will allow you to revise what has been covered so far in this tutorial. 

Pressing �  will always close down a 
menu or dialog box. 
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It is important to realise that �  will always 
provide access to the features of the current 
environment.  

For example, within the Notes application, this 
menu offers only the available options for that 
application. 

 

 

 

 
The menu for the Notes application 

Finally have a look at the tools that are 
available for managing documents when you 
choose the tools icon on the keyboard, � , by 
pressing �
 . 

Several options are marked by the symbol �  
and pressing �  on the NavPad opens their 
submenus. 

Within any application, this �  Tools menu 
retains the same features but any options that 
are currently unavailable are “greyed out”. 

The ��� �  Tools menu  

 

The next tutorial describes creating a new document and using a first TI-Nspire application.  

 

Check list of some key points in Tutorial 1. 

·  Understanding, in the TI-Nspire context, the terms document, problem, page, 
application, and home screen.  

·  Use of �  key and keyboard shortcuts. 

·  The Home Screen. 

·  The Document Browser to navigate around documents and folders. 

·  The Page Sorter to navigate inside documents. 

·  The use of �  and � . 

·  Why �  produces different menus in different contexts. 

·  The �  Tools menu. 
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TUTORIAL 2.  
THE CALCULATOR APPLICATION  

At the heart of TI-Nspire™ learning technology is the Calculator application, the workspace for 
numeric and algebra operations. This tutorial introduces some of the key features of the application, 
starting with a new blank document. This document will be saved, used again and added to in 
subsequent tutorials 

 

a) Basic operations  

First create a new blank document by 
pressing 
  and choosing option 6 from the 
Home Screen. 

To open a page which uses the calculator 
application: 

 press �  or �  or � .  

Try keying in and entering expressions using 
the four basic arithmetic operations, square 
roots, negatives etc. Look carefully at how the 
expressions as well as the results appear on 
the screen, in order to understand the 
conventions the handheld uses with its default 
settings. 

 
Choose an application  

 
Some expressions have a changed layout  

 
Use of negative and subtract  

 

Notice that in many cases the layout of the expression changes when �  is pressed—in 
particular watch how the multiplication and division operations are handled.  

Try typing a lengthy expression and, before pressing � , see the effect of using �  and 
then �� .  

 

 

 

What do you expect the result 
of this calculation to be?  

NB multiplication and 
divison. 
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b) A history lesson  

You will have noticed that, as new expressions are entered, previous ones scroll off the top 
of the screen. The TI-Nspire handheld will remember a history of up to 99 expressions and 
these can be recalled using the up key on the NavPad. Press and hold �  and see the way 
the highlight flicks back through previous expressions and results. Stop at some point in the 
history and press � . You should see either the previous expression or the result copied to 
the entry line ready to be used as all or part of a new expression. 

Notice that, after an expression has been 
evaluated, simply pressing �  again repeats 
the previous entry. What would you expect to 
see if you repeatedly pressed �  on this 
screen? Try it by pressing 

� � �  �
� ������ �
 ��� … 

 

 

Using the previous answer  

If you ever need to clear the history there is an option in the Actions submenu: press 
��� . This is also a way of producing an uncluttered screen for making screenshots 
such as the one above. 

 

c) Approximate calculations  

If you repeat the key sequence above but 
replace the first �  with � �  you get the 
rather different results shown here. Try it and 
continue pressing �  until you get an 
(apparently) unchanging approximation for 
the Golden Ratio. 

The default mode for calculations is to give 
exact results (using fractions) rather than 
approximate results (using decimals). It is 
possible to alter this using the system 
settings as you will see later in this tutorial.  

 
Decimals instead of fractions  

Another way of forcing a decimal result is to enter a decimal in the expression that you type,  
e.g. try entering 1 / 7 and then 1.0 / 7. 

Notice how entering an operation at the beginning 
of an expression (the power operation in this 
example) causes the automatic entry of Ans, 
standing for the previous answer. 
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d) Templates  

Many of the handheld’s keys provide templates to enable you to enter a range of 
mathematical expressions. For example, in this tutorial you have used the keys ��   
for square roots and �  for powers. In both cases a small box appears in the expression 
inviting you to enter values. Some care is necessary when entering more complex 
expressions using such templates. For example, try entering � 3+� 5. In order to move out of 
the box after entering 3 you need to press either �  or � .  This explains the use of �  in the 
key sequence in part b above. 

More complex templates are available from 
the Math templates menu  that can be 
opened by pressing �� . �
To make a selection from this menu you need 
to move the highlight with the NavPad and 
press � . 

Those options which have a bold T 
superimposed are not available on the basic 
version of TI-Nspire as they require a 
Computer Algebra System.  

Try using a template to produce the sums of 
the first 20 square numbers. You will need to 
use an alphabetic key such as �  to enter the 
variable name.  Press �  or use the NavPad 
to move from one small box to the next. 

Now produce the sums of the first 20 cubic 
numbers. The easiest key sequence to use is 
(probably!): 

� ��������  

 
A menu of maths templates  

 

 
A template in use 

e) Getting set  

The mode settings for a document can be 
changed using the document settings dialog 
box: press 
 � . 

 

 

  

Notice that here the first box is outlined bold, 
showing that Display Digits is selected.  
Press �  to see the range of options for fixed 
or floating decimal places. Change to the 
setting Fix 2 , by highlighting it and then 
moving to the next box using � .  

In the second box, change the angle setting to 
Degree and in the fifth box choose 
Approximate .  

 

 

 
Document settings dialog box  

 

With dialog boxes it is important to 
realise that you need to press �  
to move through the various options. 
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Keep pressing �  until the OK button is 
highlighted. Then press �  to apply the new 
settings to your document.  

You should see that the important settings at 
the top of the screen have been changed. 

Do some calculations to see the effect of 
these changes before returning to the default 
settings, Float 6 , Radian  and Auto .  

 

f) Some algebra  

The calculator application allows you to define 
variables as single numbers, functions, lists, 
matrices and even strings.  

There are three equivalent ways to store a 
variable. 

 
The effect of changed settings  

You can use   �	   (store),  

or  !"  (both characters)  

or  Define       

Define can be typed letter by letter, followed 
by a space or alternatively it can be entered 
from the Catalog: press�#$  to find it. 

Notice also you can: 

·  display multiple values in a list using 
curly brackets; 

·  use a colon for multiple statements 
on the entry line. 

 
3 ways to define variables  

In the last entry the value of r was changed to 5 but  
notice the difference between a and c(r): whereas  
c is a defined function of r, a had been given a  
particular value. 
 

This screen illustrates the use of function 
notation on the calculator screen. Notice that 
h(g(x)) can be evaluated numerically but TI-
Nspire CAS would be needed to evaluate it 
algebraically. 

You will see in Tutorial 4 that functions 
defined like this in the Calculator application 
can then be used in the Graphs and Geometry 
application. So please enter these definitions 
of g(x) and h(x) on your handheld now. 

 
Use of function notation  

In APPRX mode all 
results are shown as 
decimals rather than 
fractions: c.f section a. 

What you type is not necessarily what 
you get: above � r2 and 2� r were 
actually typed.  
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g) The Calculator menu  

Press �  and look at the extensive system of 
menus and submenus available in the 
Calculator application. If you used the TI-83 or 
TI-84 graphics calculators you will be familiar 
with many of these expressions.  

Full details can be found in the Guidebook. Part 2. p.35f. 

This screen shows a simulation of 100 throws 
of two dice and uses commands from the 
Probability and Statistics sub-menus.  

To enter randInt  you can either press  

 �%%&  �
to navigate through the menus or you can 
spell it out, letter by letter.  

You will find the mean command by pressing 
 ���� . 

 

 

Please store lists of 100 dice throws in d1 and 
d2 for use later. 

 

 

 

 
Lists of random integers  

 

h) Variables linked to documents  

Press 	  and you will see a floating menu 
showing all the variables that you have 
defined while using the current document.  

When you load a different document these 
definitions will be replaced by those linked to 
that document. Make sure your list includes 
the variables g, h, d1 and d2 and then save 
the document, giving it the name FirstSteps. 
The Save As..  option is in the Tools/File menu 
so press �
�% , type the 
filename and press � .  

List of defined variables  

 

Check list of some key points in Tutorial 2. 

·  The layout of expressions often changes when they are evaluated. 

·  Previous expressions and results can both be recalled for subsequent use. 

·  Evaluation can be either approximate (decimals) or exact (fractions). 

·  How to use templates and menus. 

·  Changing from default document settings. 

·  Defining and using variables. 

Notice that the expression d1+d2 produces a list of 100 sums of the 
corresponding values from d1 and d2 i.e 100 totals when 2 dice are thrown  
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TUTORIAL 3.  
THE NOTES APPLICATION  

This very short tutorial introduces this simple, innovative application and deals with how to split the 
screen. 

 

a) Why use Notes?  

TI-Nspire documents may be readily shared 
with others, so teachers can prepare and then 
distribute documents that are a type of 
electronic worksheet. The Notes application 
allows documents to include: 

·  text instructions for the user; 

·  space for the user to document their 
own mathematical activities; 

·  a means of teacher-student and 
student-student interaction. 

 

 
Various text formatting 

 

 
Instructions  

 
Recording results  

 

b) Making notes   

Open the FirstSteps  document that you created in Tutorial 2. 

Open a new page for notes in that document by pressing 
% . 

Enter some text using the alphanumeric keys. For upper case letters use the shift key, � . 
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Press �  to see the various options available 
when using the Notes application. 

Try to format some text. 

 

 

To select a block of text for formatting hold 
down the shift key, � , while you move 
around the text using the NavPad. 

 
  

The Format sub-menu 

c) Splitting the screen  

In any application you can split the screen into 
two or more parts using the Page Layout 
option in the �  Tools menu.  

Press �
�&  and you should see 
the various standard options available. The 
icons on the left of the menu indicate the way 
the screen will be split. 

 

Choose any of the options to see your text 
appear on a split screen.  

 

 

 

 

 

 

 

Add a Calculator application area to your page 
and experiment with using Notes and 
Calculator together. 

 

 
Ways to split the screen 

 

 
You must press  ����  ����  and then ����  

The option Custom Split  enables you to change the width or height of sections of the page. 
It can be used either when the page is first being split, or subsequently to edit an existing 
split page. 

Important: to move from one part of the 
screen to another you need to press:�  
� ���  � .��
The icon '  printed on the keyboard 
provides a helpful reminder. 
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d) More options from the Notes menu  

Mathematical expressions can be entered 
(and evaluated) on a Notes page.   

Ref: Guidebook, Part 2 p. 335. 

In addition the menus in the Notes application 
provide: 

·  two templates for Q+A and Proofs 

·  teacher and reviewer comments  

·  small shapes such as �  

Have a look at the examples of their use 
shown here. If you want to explore them 
choose the relevant options after pressing 
� .  
 

 
An inserted comment 

 

 
Use of Q+A template 

 
Use of proof template and symbols 

 

Save your revised FirstSteps  document before going on to the next tutorial. 

 

 

Check list of some key points in Tutorial 3. 

·  some possible uses for the Notes application; 

·  creating and editing page layouts with split screens; 

·  moving from one part of a split screen to another; 

·  accessing templates from the Notes menu. 
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TUTORIAL 4.  
GRAPHING 

The Graphs & Geometry application is probably the most visually exciting of the TI-Nspire™ 
applications. This tutorial introduces the application and then concentrates on its use for graphing and 
exploring functions. The application’s use for creating and exploring geometrical shapes is covered in 
Tutorial 5. 

 

a) Graphs & Geometry: two views  

Start by opening the document FirstSteps  that you created in Tutorial 2. Press 
&  to 
create a new page with the Graphs and Geometry application. You should see the Graphing 
View, with the coordinate axes defined by the default window settings and an entry line at 
the bottom of the screen. 

Press �&� to open the View menu and &  to choose the Plane Geometry View. This 
view has no entry line or axes and is ideal for drawing geometrical shapes. Tutorial 5 will 
explore this aspect of the Graphs & Geometry application.  

Return to the View menu and notice that several options are now grey, indicating that they 
are not available in this view. Choose option 1 to return to the Graphing View. 

 

b) Graphing functions  

Alongside f1(x)= enter 0.2x2–3 to see the 
screen shown here.  

Notice the label that appears alongside the 
function’s graph and the way the entry line 
now shows f2(x)=. 

In Tutorial 2 you defined the function 
g(x):=x+4. Alongside f2(x)= enter g(x) and 
draw the straight-line graph. 

Notice that the active part of the screen is still 
the entry line.  

 
The Graphing View 

Press �  repeatedly and the highlight moves to different locations on the screen.  
Highlight the double arrow in the bottom right-hand corner and press � . This enables you 
to see all the functions entered so far––the function history. Press �  twice more and you 
move to the main work area with a cursor in the form of an arrow.  

 

c) Grab and drag practice  

Use the NavPad to move the arrow around the work area. Notice that you are not restricted 
to vertical and horizontal movements. As you move the cursor over the objects in the work 
area, three things may happen: 

the cursor changes shape;  
 the underlying object flashes: 

labels of the various objects appear, e.g. axes, graph etc. 
In some positions two or more screen objects overlap and you are prompted to press the 
�  key to toggle through the labels of various overlapping objects 
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Move the cursor to the position shown here. 

Make certain that the open-hand icon is 
showing over the flashing label for f1(x) and 
grab the label by pressing �� .  

Notice that the fingers of the hand close up 
indicating that you have successfully grabbed 
this label. Use the NavPad to drag the closed-
hand icon and the function label to a new 
position. Press �  to stop dragging. Being 
able to grab and drag items is one of the most 
powerful features of the Graphs and 
Geometry application and one that will be 
used frequently in Tutorial 5. However, some 
skill and patience is often needed to grab 
exactly the right item and, without care, 
mistakes can easily be made. 

 

d) Changing the axes  

The open-hand cursor 

Get some more practice at grabbing objects 
as follows. Move to a tick mark on the x-axis 
such as the one shown here representing x=6. 
Make certain that you can see the open-hand 
icon—if you see an upward pointing index 
finger you are selecting the axis itself, not just 
the tick mark. 

Grab the tick mark and move gently to the left 
or right watching the effect. Notice that both 
the x- and y-axes are rescaled.  

Press �  and ��  to undo this and return 
to the default axis settings. 

Now grab the tick mark again and this time 
hold down the shift key, � , while you move 
left or right. This time the x-axis is scaled but 
the y-axis is unchanged. 

 

You have just used a direct method for 
changing the axes, but there are a number of 
other ways to do this. Press �%� and you 
will see this Window sub-menu. Option 1 
allows you to enter numerical values to 
determine the extremes of the axes, while the 
Zoom options, as on the TI-83/4, provide 
automatic rescaling.  

All the Window menu options are explained in the 
Guidebook Part 2, page 68-9. 

 
Grabbed tick mark on the axes 

 

 
The Zoom settings  

If you do end up moving the wrong item, remember that 

�� � can always be used to undo the last change. 
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It is worth mentioning one final very useful 
way of changing the position of the axes, but 
without rescaling them. Move the arrow cursor 
to an empty part of the screen and grab the 
vacant space. An appropriate icon appears 
indicating that you are grabbing the whole 
working area. Now you can use the NavPad to 
reposition the axes as you wish. 

 

 
The grabbed-sheet icon 

Use the (default) Zoom-Standard option from the Window menu before continuing. 

e) Editing, deleting or hiding a function  

Suppose you wish to make f2(x)=x+2. As well 
as changing g(x) in the Calculator application 
on page 1.1, you can make the change in two 
ways on this page. 

(i) In the work area, move the pointer to 
the label, f2(x)=g(x) and, instead of grabbing 
it, double-click on �  and an editable box 
opens up. 

(ii) Press ��  to highlight the function 
history area and scroll up to edit f2. 

Functions may be deleted in similar ways. 

To hide a function’s graph click on the 
Hide/Show button. 

 

 

 

 
Changing f2 in the function history  

f) Tracing graphs  

Press ���  to choose the Graph Trace 
option. 

 

 

 

Press �  and �  to trace along the graph and 
see the coordinates of current points. 
Progress is slow along the curve but you can 
change the Trace Settings to increase the 
Trace Step: press ��&� and try a step 
of 0.5 or 1. To start tracing at an integer value 
of x, in Graph Trace mode simply type the 
integer and press � . 

Press �  or to move to the other graph and 
�  or again to draw a vertical line through 
the current point.  

 

 

 

 
Trace picks out significant points 

Notice the Trace icon in the top left corner of 
the work area.  This is typical of many of the 
options from the menus.  
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Notice that, while tracing along a graph, significant points such as maxima, minima and 
intersection with the x-axis are automatically identified. 

To stop tracing you need to press � . Check to see that the Trace icon is no longer 
showing in the top left corner. 
 
g) Points and coordinates  

Here is the way to mark points of intersection 
of two lines. 

·  Press �(�  to choose the 
Intersection Point(s) option. Notice the 
icon has appeared in the top left corner.  

·  Move the cursor to the graph of f1(x). With 
the graph flashing, press � . 

·  Move to the graph of f2(x). With the graph 
flashing press � .  

Notice that the Intersection Points icon is still 
visible so you can go on to mark more 
intersections. For example you could try 
marking where the two graphs cross the y-
axis. 

 

 

 

Points of intersection 

Now press � .  

You can display the coordinates of marked 
points using the Coordinates and Equations 
tool: press ���  and move to the point 
you marked where the curve crosses the 
vertical axis. Double-click on �  to fix the 
coordinates on the screen. 

Escape from that tool and choose instead the 
Text tool: ��( . Try labelling one of 
your fixed points by moving carefully to the 
point––make quite certain that only the point 
is flashing and not one of the graphs or axes.  

Points, lines and shapes can be drawn and 
manipulated on the graphing work area and 
this will be explored in the next tutorial. 
However, one more thing to try now is putting 
a grid on the work area. Press �&� . 

 

 

 

Coordinates and labelled points  

  

 

It’s easy to change the number of decimal places 
displayed: move the cursor over a displayed 

value and press )� or � . 
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h) Manually moving graphs  

You saw in section e that, when you change a function’s equation the graph changes. An 
innovative feature of TI-Nspire is that you can also do the reverse, i.e. manually manipulate 
the graph and see the function’s equation change. As the graph moves, all associated 
features such as points of intersection and their coordinates also change. 

 
First move the straight line graph, as follows. 

Check that no icons are still showing in the top 
left corner of the work area and then move the 
pointer to the graph of the function f2(x)=x+2. 
The line should flash and you will see one of 
the two icons shown here, depending on 
where exactly you are on the screen. Move 
along the line and you will discover the other 
icon. 

Near the middle of the graph the icon 
suggesting translation appears, while the one 
suggesting rotation appears towards the ends 
of the graph. Decide which you would like to 
use and grab the line by pressing �� . 

Use the cursor button to move the graph 
around. Notice the way that the function’s 
equation changes too. 

Press �  and try the other transformation. 

You can manipulate the quadratic function too: details in 
the Guidebook, Part 2 p.111. 

 

 

   

Alternative icons  

 

 
Transformed graph and equation 

 

Many of the techniques that have been introduced in this tutorial, in particular fixing points, 
grabbing and labelling them, will be used again in Tutorial 5. In Tutorials 6 and 7 you will 
see how the Lists and Spreadsheets application allows tables of values to be formed from 
functions defined in the Graphs and Geometry application. 

Finally save the FirstSteps document so that you can refer to these graphs later. 

 

Check list of some key points in Tutorial 4. 

·  Items visible in the graphing view: the work area, the entry line, the function history, 
the warning icons in the top-left corner. 

·  Entering, editing, deleting and hiding functions. 

·  Grabbing and dragging labels. 

·  Setting the axes in three ways: by dragging, zooming and entering values. 

·  Tracing along graphs. 

·  Marking and labelling points and their coordinates. 

·  Transforming graphs and their functions manually. 
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TUTORIAL 5.  
GEOMETRY 

This tutorial introduces interactive geometry on the TI-Nspire and builds upon the methods and 
features of the Graphs and Geometry application that were covered in Tutorial 4. You are led step by 
step through a geometrical construction which illustrates the simple concept that the areas of 
triangles with a fixed base and constant height are equal.  As you work through the construction you 
will meet many of the features that make this one of the most powerful and attractive components of 
TI-Nspire. 

 

a) A view for plane geometry  

If necessary open your FirstSteps document 
and use the 
  key to create a new Graphs 
& Geometry page. For geometrical work you 
will not need the axes or the entry line and 
these could be hidden using options 4 and 6 
in the View menu. However, objects 
constructed will still be fixed relative to the 
axes, with hidden coordinates etc. A better 
environment for pure geometrical exploration 
is provided by option 2 from the View menu, 
the Plane Geometry View. 
 
Choose this view now. Notice that it provides 
a scale in the top right hand corner which can 
be hidden using option 7 in the View menu. 
 
Note: for more detail about different behaviour of objects 
in the two available views please see the Guidebook 
Part 2 p77-80.  
 

 

 

 
Options for geometry in the View menu 

b) Two parallel lines  

Start by drawing a line to represent the base 
of a triangle and label it BC: press �(  to 
see the options available for drawing Points & 
Lines. Segments have two distinct end points, 
lines are (in theory) infinite, while rays have 
just one end. So choose option 5: Segment .  
 
Move the cursor to a suitable position for point 
B. Then press �  to fix the point and �*  
to give it a label. 
Move the cursor to where you want the other 
end of the segment to be. Mark the point and 
label it C. The icon in the top left corner is still 
showing you that you could draw another 
segment if you wish. Press �  to remove the 
icon and leave that mode of operation. 

 

 

 

 
Drawing the base of the triangle  

Notice that as usual the relevant icon 
appears in the top left corner of the screen. 
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The next step is to draw a line parallel to BC. 
This is a construction so you need to press 
�+ . 

Choose option 2: Parallel . 

You must specify two things: the position of 
the new line and the line to which it is to be 
parallel. So move the cursor to the segment 
BC––you will see its label when you are in the 
right position. Press �  to select the 
segment, move away, dragging a dotted 
parallel line and when happy with its position 
press �  again. Once again, don’t forget to 
press � . 
 

 
Many options in the Construction menu  

c) What’s grabbable?  

At this point it is worth moving the cursor 
around the screen to see which objects can 
be grabbed and dragged. 

You should see the open hand cursor appear 
for point B, for point C, for the segment BC, 
and for the point fixing the parallel line. All of 
these are grabbable.  

However, the parallel line itself cannot be 
grabbed and dragged. The pointing finger 
shows it can be selected for various purposes. 
For example, you could delete it by pressing 
�  to select and then �  to get rid of it. 
 

 

 
Selectable, but not grabbable! 

d) Construct the triangle  

First, a point A is needed on the parallel line. 
Later you will be sliding this point along the 
line without moving the line itself, so the point 
that you have already which defines the line is 
not a good one to use.  Therefore press 
�(&  to select the option: Point On . 
Move the cursor to a new point on the line and 
press  
 ��,� .�
The triangle itself can be constructed using 
the Shapes menu. Select the Triangle  option, 
check that the correct icon is showing in the 
top left corner, and then carefully select, in 
any order, each of the points A, B and C. 
Make certain you don’t press �  to select a 
point until its label and the pointing-finger icon 
appears as shown here. 

 

 

 
 Point C is ready to be selected 
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e) Making measurements  

With a triangle drawn on your screen, the next 
step is to measure its area. Choose option 2: 
Area from the Measurement menu and then 
move the cursor to one of the sides of the 
triangle. The triangle label and the pointing-
finger icon appear together with a calculated 
area in the background. Press �  to confirm 
the choice of the triangle, �  again to show 
the measurement and then �  to remove the 
icon from the top left corner. 

A very precise number of cm2 has appeared 
as text on the screen. Grab this text and move 
it to the bottom centre of the screen so that it 
can be seen easily. (See Tutorial 4, section c) 

Place the cursor over the calculated value 
(you should see the open-hand icon) and 
press )  several times. The effect is to 
reduce the number of displayed decimal 
places. This feature can be applied to any 
numbers on the screen in the Graphs & 
Geometry application. 

 

Measurement menu       

 

f) Variables and text  

There are two ways to make it clear that the 
measurement at the bottom of the screen 
represents an area. One method is to simply 
add some text alongside the measurement. 
However, a more powerful method is to 
allocate the measurement to a variable and 
display the variable name alongside it. To do 
this: 

·  move the cursor over the 
measurement (you will see the open-
hand icon;  

·  press 	  and choose option 1: Store 
Var; 

·  use the alphabetic keys to give the 
variable the name “area”. Press � . 

This variable may now be used on other 
pages of the document. For example, if you 
move to a Calculator page, type and enter 
area, the current value of the area will be 
used. 

 

 

 

 

 
Storing the measurement as a variable 

 

Notice the range 
of other possible 
measurements 
available from 
this menu. 



� � First Steps with TI-Nspire™ 
  Tutorial 5: Geometry�
 

�������� � �����	�
�����
���������������������
���������  

Now move to the top of the screen and enter some text, perhaps giving the user some 
explanation or instructions. You will need to press: 

·  ��(   to select the Text option, 

·  �    to open up a box where text can be entered. 

 

g) Dynamic changes  

If you haven’t yet done so, try grabbing point 
A and sliding it along its line. Make quite 
certain that you grab the point––you must see 
its label. You may need to press �  until the 
point itself, rather than the triangle or label is 
selected. If you do select the wrong item it’s 
well worth remembering that ��  will undo 
any action if something happens that you 
didn’t intend! 

Notice that as you move the point, two sides 
of the triangle and the label A all move too. 
What does not change is the area. 

 
Ready to grab A and slide it 

Now try grabbing and dragging point B or C, and then the line segment BC and the line 
parallel to it. In each case notice which other items on the screen move, and which do not. 
Thinking about how each item was originally defined should explain whether it moves in 
relation to other items. 

 

h) Tidying up and using attributes  

Finally it’s well worth seeing how to improve the appearance of the screen and preventing 
items from being grabbed unintentionally. 

For this activity the scale in the top right corner may not be needed.  
You can hide it with option 7 in the View menu. 

The point that defines the parallel line may be 
rather distracting, so you could hide it using 
option 3 in the Actions menu. 

 

Now from the Actions menu choose option 4: 
Attributes .  

Move the cursor to one of the sides of the 
triangle and press �  to select it. With the 
careful use of the NavPad you can choose to 
display the sides and the interior of the 
triangle in different ways.  

Press �  to confirm your choices. 

 
Changing the attributes of the triangle 
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With the attributes function still active (check 
the top left icon) move the cursor to point B 
and select it.  You can change the 
appearance of the point but you also have the 
option of locking the point, that is preventing 
users from grabbing and moving it. For 
example, there may be good pedagogic 
reasons for only allowing point A to move in 
this activity.  For the moment lock points B 
and C. 

Continue to move the cursor around the 
screen and see the options for changing the 
attributes of the parallel line and also the area 
measurement. Locking the measurement will 
fix the current value constraining movement of 
other points accordingly. 

 

 
Point B is now locked 

 

 

Locking some objects and unlocking others can have very interesting effects and if you have 
time you may care to investigate the following situations. 

a) Locked: The area measurement. 

 Unlocked: Points B and C and the parallel line through A. 

 Move B 

b)  Locked: The area measurement and the parallel line through A. 

 Unlocked: Points B and C. 

 Move B 

 

Once again save your FirstSteps document before going any further. 

 

Check list of some key points in Tutorial 5. 

·  Use of the Plane Geometry View rather than the Graphing View. 

·  Lines, segments and rays. 

·  Constructing parallel lines. 

·  Drawing points on objects and labelling them. 

·  The construction of shapes. 

·  The difference between selecting and grabbing screen objects 

·  Making a measurement and storing as a variable. 

·  Attributes which change the appearance and lock screen objects. 
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TUTORIAL 6.  
LISTS & SPREADSHEET  

The Lists & Spreadsheet application is a very powerful means of manipulating data lists and works 
seamlessly with the other applications to provide multiple representations of data. This tutorial 
introduces the application, showing how to use it as a simple spreadsheet. It also shows how the 
Lists & Spreadsheet application handles lists and functions defined in the Calculator and Graphs & 
Geometry applications, drawing on ideas covered in Tutorials 2, 4 and 5.  

In Tutorial 7 you will see how Lists & Spreadsheet is used in conjunction with the Data & Statistics 
application to produce charts and statistical summaries. 

 

a) Entering data as lists   

Open your FirstSteps document and press 
�  to add a new page using the Lists & 
Spreadsheet application. 

Enter some data similar to that shown here 
which will be used again in Tutorial 7: 

·  column A represents male shoe sizes, 

·  column B has widths of hand spans in 
cm (paired data with column A) 

·  column C is female shoe sizes.  

You will need 20 or 30 pairs of similar data 
in columns A and B and at least 15 values 
in column C. 

Notice the similarities and differences 
between this screen and a traditional 
spreadsheet. In particular notice the two 
areas coloured white and grey at the top of 
each column.  

·  The white area is for list names. 

·  The grey area is for formulas that will 
apply to all items in the list below. 

Move to the white space beside A, type 
mshoe and press � .   

What you have just done is to define a new 
list. If you were to move to a Calculator 
screen, pressing 	  would reveal mshoe 
as one of the defined variables and lists, 
and entering the name on that screen 
would produce the result 
{11,8,7,12,9.5,…..} 

Define the data in columns B and C as lists 
mhand  and fshoe . 

 

 
Differences from a spreadsheet? 

 

 

 
Defining the list in column C  

Lists can also be defined in the Calculator 
application:recall Tutorial 2, part f. 
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b) Using formulas  

Suppose you wished to investigate the relationship between hand spans and shoe sizes. 
You might therefore wish to divide every hand-span measurement by the corresponding 
shoe size. These ratios would best be expressed in decimal rather than fractional format so 
change the 5th Document Setting to Approximate.    Ref. Tutorial 2, section e 

There are 3 ways (at least!) of calculating the ratios on the TI-Nspire. Try one of the 
following now. 

Either:  in cell D1 type the expression =B1/A1. Select D1 and fill down the column by 
pressing �  and choosing the options 3: Data and 3: Fill Down .  

Or:  in the grey formula area at the top of column D enter =mhand/mshoe . 

Or:  in the grey formula area enter =b/a. Since there is possible ambiguity, you will 
probably get a response similar to that below. Once the machine is clear that you 
mean the data in column A it automatically inserts the square brackets as shown 
below. 

 
Conflict resolution.  

 

 
 

One way to enter a formula 

 

Press �  and notice the various options 
available in the Lists & Spreadsheet 
application. 

The TI-Nspire has most of the editing 
features that you would expect from a 
spreadsheet including resizing, selecting, 
inserting, moving and deleting rows, 
columns and cells.  

Typical spreadsheet actions 

You can also create absolute cell references in the usual way using $ chosen from the 
Symbol Palette (�# ) and you can sort data in columns (��( ).  
Ref:T I-Nspire Guidebook, Part 2, pp 173ff. 
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c) Capturing data  

A powerful feature of the TI-Nspire is its ability to capture data from a Graphs & Geometry 
page.  Follow through these steps to see an example of how this works, using the 
measurement of the area of a triangle from Tutorial 5. 

·  Create a new Lists & Spreadsheets page: (
� ). 

·  Choose the Manual Data Capture option from the menus (��&& )  
You should see in the entry line: =capture(var,0) 

·  Overtype var by typing the variable name area.  

·  Resize the column (Press ��&�  and use �  to make the column wider. 

·  Move to cell A1 and capture the current value of area by pressing �- .  

·  Move to the page where you constructed the triangle. If necessary unlock point B 
and grab and move it. Notice that this changes the area.  

·  Return to page 1.6 and in cell A2 press �- . 

In the formula the second parameter, 0, 
indicates manual capture was selected. An 
interesting variation involves using automatic 
capture (parameter 1). Either edit the formula 
in column A or enter it in column B. Then grab 
and move point B around again and see the 
huge amount of data that are generated. (See 
the Appendix for more ideas about using this feature). 

If you have time you may care to measure the 
base and height of the triangle on the 
Geometry page and capture these values on 
the Spreadsheet page. How could such 
features be used to develop an understanding 
of triangle area? 

 
Capturing data by hand 

 

d) Function tables  

It is quite possible to create from scratch a 
table of values for functions that have been 
defined elsewhere in the current document. 
For example, the screen shown here uses the 
definitions of f1 and f2 that were used in 
Tutorial 4: their graphs are probably still drawn 
on page 1.3. Don’t worry if the values you see 
are different from these––in Tutorial 4 you 
were asked to move the graphs around, 
changing the functions.  

A hand-made function table 
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Because function tables are so useful, they 
can also be drawn automatically. Follow 
through these steps. 

·  Create a new Lists & Spreadsheets 
page and press ���  to switch 
to a function table. Notice the different 
layout of the screen and a box with a 
list of the currently defined functions. 

·  Choose function g and scroll up and 
down.  

·  Press ��  again. These are the 
only options that are available now: 
you cannot resize the columns or 
insert cells as you can when using the 
spreadsheet view.  

·  Experiment with using option 3: Edit 
Function Table Settings . 

·   Now use option 5: Edit Function 
Expression . You will see the values in 
the table change and, if you go back to 
Page 1.3 you will see that the function 
and graph have changed there too. 

 
A simple function table 

 
Options for function tables 

Having a function’s table on the same page as 
its graph can clearly be a powerful learning 
tool and there is a very simple way of 
arranging this on a split screen. Go to page 
1.3 of your document and choose option 9 in 
the View menu. 

With a split screen of this nature it is as well to 
remove all unnecessary clutter. Here the entry 
line at the bottom of the graphing screen has 
been removed, labels and unnecessary 
functions deleted. Also the vertical split 
between graph and table was adjusted using 
the option Custom Split  from the Tools/Page 
layout menu. (�
��� ). 

 

 
Graph and table side by side 

Check list of some key points in Tutorial 6. 

·  Entering and editing data and formulas. 

·  Lists and functions defined in other sections of the document. 

·  Coping with ambiguous variable/cell names. 

·  Capturing data from the Graphs & Geometry application. 

·  Use of function tables. 

The Function Table view is an alternative for 
any Lists & Spreadsheet page. You can  toggle 
between the two views using �.  
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TUTORIAL 7.  
ONE- AND TWO-VARIABLE STATISTICS  

One of the five core applications of TI-Nspire™ is Data & Statistics, the workspace for presenting, 
interpreting and manipulating statistical charts and graphs. This application works in combination with 
the Lists & Spreadsheet application and this tutorial uses the data that were entered as a 
spreadsheet at the beginning of Tutorial 6.  

 

a) Shoe sizes and hand spans  

Start by locating in your FirstSteps Document 
the page that you created in the first part of 
Tutorial 6. There should be 20 or 30 pairs of 
(probably fictitious) data in columns A and B 
and at least 15 values in column C. 

·  List mshoe  in column A represents 
male shoe sizes. 

·  List mhand  in column B has widths of 
hand spans in cm (paired data with 
column A). 

·  List fshoe  in column C represents 
female shoe sizes. 

 

b) Charts with one variable  

To create a new page for the charts press 

� .��

�

 

Move the cursor to the bottom of the screen 
where it says: Click to add variable. Press � . 

A list of currently defined variables opens up, 
so use the NavPad to select mshoe and press 
�  or � . 

Initially you will see a dot plot.  

Press �� � to see the Plot Type menu, 
which gives nine types of plot. Because you 
have only defined a single numerical variable 
so far, there are only three alternative plots 
including a boxplot and a histogram. 

Try these options now. 

Data entered in Tutorial 6 

 Choosing a variable 

Three plots for numerical data  

Randomly distributed points: no 
variables have yet been assigned. 
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Display the boxplot and then move the cursor 
over the chart. You will be able to see the 
median, quartiles, maximum and minimum 
values and, possibly, outlier values. 

 

 

c) Comparing boxplots  

This boxplot can be compared with a similar 
one representing the female shoe sizes by 
displaying them, one above another, with a 
split screen. 

·  To split the screen horizontally: press 

� �
�&� . Ref Tutorial 3(c). 

·  To move to the lower part of the screen 
and choose Data & Spreadsheet again 
press:����� . 

·  Move to the prompt to add a variable, 
press �� and select the variable fshoe . 

·  Change the chart to a boxplot and, for 
the best comparison, change the window 
settings so that the two axes are the same. 
Ref: Tutorial 4(d). 

 

 
Upper quartile displayed 

 

 Comparing shoe sizes  

d) Charts for categorical data  

Create a new Data & Statistics page and 
choose the variable mshoe for the x axis. 

This variable contains a list of numerical data 
but they could also be thought of as 
categorical data, in which case it would be 
appropriate to use a Pie Chart. By using the 
option Force Categorical X  in the Plot 
Properties menu you can force the handheld 
to treat the data in this way. Notice the way in 
which the labels on the axis change. 

Now you can use the Plot Type menu to 
choose Pie Chart. 

It is also possible to enter non-numerical 
categorical data on a Lists & Spreadsheets 
page e.g. favourite pets, sandwich fillings etc. 
Such data must be entered in quotation 
marks. 

 

 
A Pie Chart displaying categorical data  
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e) Charts with two variables  

Create a new Data & Statistics page. 

Notice both axes are marked Click to add 
variable. 

As before select mshoe  for the horizontal 
axis. 

Move the cursor to the left edge of the screen, 
click �  and select the variable mhand  for 
the vertical axis. 

This displays the scatterplot.  
Ready to add a 2 nd variable  

It may be that there is a positive correlation 
and a relationship between hand span and 
shoe size, so it may be appropriate to model 
this relationship with a linear function. The 
Analyze menu provides a range of tools to 
use. 

 

f) Fitting a line by hand and eye  

First try adding a line of best fit by eye, using 
option 2: Add Movable Line . This displays a 
straight line together with a functional 
relationship between mshoe and mhand.  

The line can be dragged into a best-fit position 
using the two cursors for rotate and translate, 
in exactly the same way as a straight line can 
be moved manually in the Graphs & Geometry 
application.  

Ref Tutorial 4(h). 

 

 

 
Powerful options in the Analyze menu  

 
Translating the line  

 
Rotating the line  

Move to the middle of the line to get the translate 

cursor. Click and hold �  to grab it. Now move the 

line into position. Press �  to release the cursor. 

Move towards one end of the line to show the rotate 

cursor. Click and hold �  to grab it.  Use the NavPad 

to rotate the line. Press �  to release the cursor 
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g) Drawing the regression line  

The line that was fitted by hand and eye can 
be compared with the calculated linear 
regression line using option 4 in the Analyze 
menu. Pressing �%(�  will display a 
line with equation of the form y=mx+b. 

As usual, you can click and drag on the 
regression equation to move it to a convenient 
place. 

 
The calculated regression line  

h) Getting the stats  

There are two methods for displaying 
summary statistics: 

1. For a single statistic you can type its 
name and use the 	  key to choose 
the variable, e.g. median(fshoe). 
Ref: Tutorial 2 (g). 

2. On a Lists & Spreadsheet page, you 
can enter a complete set of statistics 
into spreadsheet cells. 

Open a new Lists & Spreadsheet page and 
press��%�  to see the range of 
statistical calculations. (Once again these will 
be very familiar to users of the TI-83/4.) 

 

Choose option 1: One-Variable Statistics .  

You have the option to display stats for more 
than one list but for now choose 1 list and 
then OK. 

 

 

Choosing the data list can either be done 
using the NavPad, or you can type the name. 

 

Type the letter of the column where you want 
the results to appear. 

 

 
The Statistics Calculations menu 

 

 
Select one list 

 

Press �  to move 
to the next box. 
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It is also possible to arrange side-by-side 
comparisons of corresponding summary 
statistics for two or more data sets and this 
makes drawing inferences from the statistics 
very quick and very clear. 

i) Dragging on the charts  

An interesting  feature is the ability to drag 
plotted points around charts, thus changing 
the original data. if Go back to the page on 
which you created the scatterplot for male 
hand spans and shoe sizes. You left the plot 
showing the y=mx+b regression line and 
equation. 

 
Sets of statistics  

Move the cursor to a point very near the line of best fit. The cursor changes to a hand with a 
finger pointing upwards when it is pointing to a data point. Click and hold � .  
Move the cursor to investigate the effect that moving this point has on the regression line. 
Below, the point has been moved to the top of the screen for maximum effect.  

 
The effect of moving a point from here …  

 
… to here.  

 
 

 

 

Check list of some key points in Tutorial 7. 

·  Creating one- and two-variable statistical plots in the Data & Statistics application. 

·  Plotting categorical as opposed to numerical data. 

·  Using boxplots to compare data sets. 

·  Calculating and displaying summary statistics. 

·  Manually fitting straight lines to data.  

·  Automatically fitting linear-regression lines to data. 

·  Dragging points on a scatterplot.

NB. This shows the effect of changing a single hand-span value from 21 cm to 28 cm. 
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APPENDIX  
MULTIPLE REPRESENTATIONS – AN EXAMPLE  
The previous seven tutorials have introduced many of the key features of TI-Nspire learning 
technology, with each of the applications being discussed separately. However, one of the great 
strengths of TI-Nspire is that it allows the applications to be linked dynamically, encouraging different 
approaches to problem solving. This appendix offers an example of what is meant by  “multiple 
representations”, showing how several of the applications can be used to investigate a mathematical 
concept, in this case the relationship between a circle’s diameter and circumference and between its 
radius and area.  

By working through this appendix you will be able to revise many of the skills and techniques you met 
in the tutorials. Here detailed instructions and key presses have been omitted though you will find 
back references if you need to remind yourself about particular techniques. However, try to 
concentrate on the big picture of what is going on, asking yourself how each of the multiple 
representations contributes to a deeper understanding of the mathematics.  

 

 

a) Draw and measure a circle  

·  Open a new document with a Graphs 
and Geometry page. 

·  From the View menu choose Plane 
Geometry View . 

·  Construct a large circle on the screen. 
·  Construct a radius by drawing a 

segment  from the centre to the 
circumference. 

·  To construct a diameter first construct 
a line  (not a segment) from the centre 
to the circumference. Then construct 
the Intersection Points  of the line and 
the circle: this generates the point on 
the opposite end of the diameter. 

·  Now measure the lengths of the radius 
the diameter and the circumference. 
Also measure the area. In each case 
change the number of decimal poits 
displayed. 
(Ref. Tutorial 5e). 

·  Finally assign the measurements to 
variables. Click on each measurement 
in turn. Press 	 . Type the letter 
appropriate for each measurement (r, 
d, C and A) and press � .  
(Ref. Tutorial 5f). 

·  Check that the measurements change 
when you grab the circle and change 
its size. 

 
 

 

 

 

 

 

 

 
A measured circle 
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b) A spreadsheet for data capture  

·  Open a new Lists & Spreadsheet page. 
·  Type column headings for columns A 

to D. 
(Ref. Tut 6a). 

·  Click in the function entry line in 
column A (just below the heading). 

·  From the Data menu choose 
Automated Data Capture . Type r and 
press � . This will capture values of 
the radius in column A. From the 
Conflict Detected menu choose 
Variable Reference  and click OK. 
(Ref. Tutorial 6c). 

·  Repeat for the other variables in 
columns B to D. 

·  Check that the data that appear are the 
same as the current measurements on 
the previous page. 

 

 
Beginning to capture data 

 

c) Two scatterplots  

·  Open a Data & Statistics page. 
·  Choose the variable diameter  for the 

horizontal axis and circum  for the 
vertical axis. (Ref. Tutorial 7c). 

·  So far there is only one data pair and 
one point for the Scatter Plot. 

·  Open another Data & Statistics page. 
·  Choose the variable radius  for the 

horizontal axis and area for the vertical 
axis. 

  
Setting up a scatter plot 

d) Collecting just a little data  

·  Return to the Graphs & Geometry 
page. 

·  Click and drag on the circumference of 
the circle to move it in and out just a 
little bit . 

·  Review the amount of data you have 
collected in the spreadsheet. 

·  Review the relationships shown on the 
two scatter plots.  

·  You may need to update the window 
settings using the option Zoom–Data  
from the Wundoe/Zoom menu.. 

 
 

Data capture is under way 
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e) Go to town with data collection  

·  Return to the Graphs & Geometry page 
and drag the circumference in as far as 
you can. 

·  Review the data in the spreadsheet. 
·  Review the diameter/circumference 

scatter plot, using Zoom–Data  to 
update the window settings.  

 
 

A linear relationship 

f) Fit a straight line  

·  From the Analyze menu choose Add 
Movable Line . Drag it into place to fit 
the plotted points. 
(Ref. Tutorial 7d). 

·  To tidy the function, choose Lock 
Intercept at Zero  from the Analyze 
menu. 

·  Also review the radius/area scatter plot. 
Using Zoom–Data  here will create a 
dramatic change!  

 

Moving a straight line by hand 

Not a linear relationship! 
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g) A different approach to scatter plots  

·  Open a new Graphs & Geometry page. 
·  From the Graph Type menu choose 

Scatter Plot .  
·  Set x to be radius  and y to be area. 
·  From the Window menu choose  

Zoom–Data  and hide the entry line to 
gain a good view of the data points 
including the horizontal axis. 

·  Now choose Function  from the  
Graph Type menu. 

·  Enter f1(x)=x2. 
·  Now you can click and drag the 

quadratic curve into place to fit the 
data, just as you did in part f for the 
straight line. 
(Ref. Tutorial 4h). 

 
 

 

 

h) Regression  

Go back to the each of the scatter plots on 
the Data & Statistics pages in turn. From 
the Analyze menu choose Regression and 
place appropriate lines on the data. 

The basic quadratic ready for fitting…  

 

 
… and dragged into place 

 

  
 

What other mathematical examples lend themselves to this sort of approach? 

 


